
President’s Comments
Harvest Moon

by Roz Kleffman

The Bowie-Crofton Camera Club surely has a good supply of technical gurus. We have astro-physicists, electrical engineers, 
doctors, lawyers, nurses, accountants, teachers, computer guys and even a few retired folks. You know, there are some club 
members that can recite the history of photography without lifting a camera. Other folks know all the ins and out of those 
magical computer programs. We even have some folks that can chew gum while standing on a ladder and compose great 
photos. With 200 members, we are surely a club of some pretty interesting people.

Why not meet some one this club year and enjoy a little photography time together. We have some great field trips lined up 
for this year AND you could even venture out with one or two friends to shoot the sky. Now that the 

The Viewfinder Earns Third Place
PSA Newsletter Judges Give Newsletter 2007 Honor 

by Jeff Kendrick, Editor 

The results are back, and Bowie-Crofton’s newsletter was awarded 3rd Place by a panel of Photographic Society of America 
(PSA) judges. The May 2007 issue was submitted to PSA’s International Newsletter Contest—B-CCC competes in the large 
club category—and the entries were judged earlier this summer. Winners were announced at the PSA Conference in Tucson 
in September. Dick Whitley, B-CCC’s PSA Representative, attended the conference and received the award on the club’s 
behalf. He presented the award, a plaque engraved with the name of the newsletter and the editor, to Jeff Kendrick at the 
club’s opening meeting on September 17.
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EXECUTIVE COMMITTEE
President 
Roz Kleffman . . . . . . . . . 301•464•1867 
 . . . . . . . . . . . . . .president@b-ccc.org

VP Programs 
Drew Kalocai  . . . . . . . . . 443-277-8591 
 . . . . . . . . . . . . . . programs@b-ccc.org

VP Membership 
Frieda Weise  . . . . . . . . . 301-604-7772 
 . . . . . . . . . . . . membership@b-ccc.org

VP Competition 
Wayne Bower  . . . . . . . . . 301•262•7257 
 . . . . . . . . . . . . competition@b-ccc.org

VP How-to 
Bill Conway . . . . . . . . . . 410•326•0386 
 . . . . . . . . . . . . . . . how-to@b-ccc.org

VP Photo Talk 
Steve Bruza  . . . . . . . . . . 410•247•5997 
 . . . . . . . . . . . . . photo-talk@b-ccc.org

Treasurer 
Jim Knox   . . . . . . . . . . . 301•649•5913 
 . . . . . . . . . . . . . . treasurer@b-ccc.org

Secretary 
Joan Anne Dubbs. . . . . . . 301•262•7105  
 . . . . . . . . . . . . . . secretary@b-ccc.org

PSA Representative 
Dick Whitley   . . . . . . . . . 301•899•6457 
 . . . . . . . . . . . . . . . . . . psa@b-ccc.org

Newsletter Editor 
(also Immediate Past President) 
Jeff Kendrick  . . . . . . . . . 410•796•7612  
 . . . . . . . . . . . . . viewfinder@b-ccc.org

STAFF
Competition Assistant 
Clarence Carvell   . . . . . . 301•725•0234 
 . . . . . . . . . . . . competition@b-ccc.org

Database Manager 
Dick Russell . . . . . . . . . . 410•987•1471 
 . . . . . . . . . . . . . . database@b-ccc.org

Field Trip Captains 
Don Andberg. . . . . . dbandberg@aol.com 
Vincent Ferrari . . . . . . . . . . . . . . . . .  
 . . . . . . . . . . vincentferrari@gmail.com

Webmaster 
George L. Smyth 
 . . . . . . . . . . . . .webmaster@b-ccc.org

GRANT PANEL
Roz Kleffman, Jim Knox, Jeff Kendrick, 

Appointed: Clarence Carvell,  
Elected: David Hornick

THE VIEWFINDER is distributed via 
e-mail early in the month and at the first 
meeting of each month during the club 
year. Contributions of articles of interest 
to photographers are welcomed.

The deadline for submitting articles  
is the first Monday of the month prior 
to publication (ie, articles submitted 
on October 1 will be published in the 
November newsletter).

Articles should be sent via e-mail to 

viewfinder@b-ccc.org with the text 
directly in the body of the message.  File 
attachments (MS Word, .txt, .rtf) are 
acceptable.

Photographs should be submitted 
electronically as JPEGs with a “high” 
quality compression setting. The optimal 
photograph will be no more than 800 
pixels in its greatest dimension. 

Do not submit copyrighted material 
unless you also supply written permission 

Membership Rates

Junior (ages 12-17). . . . . $5.00 
Individual . . . . . . . . . . . $25.00 
Family  . . . . . . . . . . . . . . $35.00

Meeting Nights

The Bowie-Crofton Camera Club meets 
the first through fourth Monday nights 
of each month September through May 
in the Fellowship Hall of the All Saints 
Lutheran Church at US 301 and Mt. Oak 
Road in Bowie. Meetings begin at 7:30. 
Visitors are always welcome.

Photographic Society  
of America (PSA)

The Bowie-Crofton Camera Club has 
been a member of the Photographic 
Society of America (PSA) since 1977. 
Dick Whitley, a PSA Region Director,  is 
B-CCC’s representative to PSA. 

For information regarding the benefits of a 
PSA individual membership and for PSA-
sponsored events contact Dick Whitley 
(301) 899-6457 or e-mail psa@b-ccc.org.
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PSA Award for B-CCC Newsletter
Interesting Articles, Lots of Photos Make for Top Notch Publication 

continued from page 1

days are getting shorter you need to plan your photographic excursions.  The Farmer’s Almanac might be just the light reader you 
need. You can get phases of the moon and a lot of other interesting facts like the best time for doing a certain task.  The Farmer’s 
Almanac asks, “Ever wonder why certain chores and tasks seem to go smoother on specific days?” According to The Farmer’s Almanac 
tradition, when the moon is in the appropriate phase and place in the zodiac, it’s widely believed that activities will be more fruitful 
or lead to improved results. The period between the new and full moon (first and second quarters) is considered as the best time to 
perform tasks that require strength, fertility and growth. The period between the full and new moon (third and fourth quarters) is 
best for harvesting, retarding growth, etc. Consideration is also given to the relationship the moon has with the 12 ruling signs of the 
zodiac.” WOW!  Full moon for October will be on the 26th.

Other important things to consider are sunrise (for those so inclined) and sunset times.  Sunrise in October is about 7:07 am and 
sunset is 6:47 pm. Even I could manage that early wake-up call. When shooting sunrise or sunset, get to your destination early. You 
should be at the location at least an hour before the sunrise or sunset. Give yourself time to set up equipment and be ready for that 
moment you are looking for. Dramatic skies are usually seen 30 minutes before and after sunrise and set. You need to be ready.

Night skies offer a unique experience too.  Did you know that meteor showers occur all year long?  Although most of us will not 
venture out in January or February, consider October when the air is crisp but not frigid.  Look for the Orionids meteors October 21 
and 22. 

The seasonal changes of fall will be available for only about 2 weeks. It is time to start scouting out that location. Look for a pond 
or stream with an S or C curve to produce some interesting reflections and eye appeal.  No pond by your place? Not to worry, look 
for reflections in the buildings or a windy street. Become familiar with the area before you attempt to get that perfect shot.  Many 
great shots come from weeks of preparation so that you know where you want the photo. Try different times of the day and different 
lighting situations. Some of my best shots have occurred on slightly overcast days after rains have moved on. 

Get out and shoot that photo. Do not let these wonderful fall days pass you by.  You have all those cold winter nights to review your 
work.

President’s Comments
Capture the Spectacles of Fall

continued from page 1

The May issue which was recognized by PSA included Lawrence Smith’s image (and Novice Nature Trophy winner) Color of 
Winter on the cover and interesting feature articles by Frances Miller (Microstock Photography) Bill Conway (adding Glints, 
Twinkles and Stars to Your Photographs). Ann Krumrein and her photographs were that month’s Member Spotlight. Plenty of 
competition winning images added to the appeal of the newsletter and elevated it among the competition.  

Comments from the judges were very complimentary toward The Viewfinder, however they did recommend more careful 
proofreading. One judge stated that, “quality articles are well written and actually informative, helpful and educational... 
Photographs are not only superbly created by their maker, but are expertly displayed.”   

Among other local clubs, Pete Manzelli, editor of the Cable Release (Silver Spring) earned 2nd place in the Small Club category. 
Warren Standley of Manassas-Warrenton and Tom Sullivan of North Bethesda were given Director’s Choice Awards for Use of 
Photography and Motivational Focus (respectively) in their newsletters.

Thanks to all of the contributors to The Viewfinder. Keep those interesting articles coming. And, congratulations to the other local 
editors on their awards.
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Over the July 4th weekend, Ed Pastula, brother Doug and I went to explore the 
“new” Pittsburgh.  Our agenda included photographing the new architecturally 
dynamic and “green” Lawrence convention center, both inside and out, and trying 
for grand panoramics from the heights on Mount Washington. The convention 
center has dynamic design qualities, is mostly glass & aluminum on the outside, 
and thrusts out over the river to imitate the lines of the numerous nearby bridges. 
To our disappointment, they would not let us into the center unless we were paying 
participants.  However, one fantastic view of it from the Heights looking up the 
river shows how the architect’s vision of thrusting form was realized. 

The gods must have been on our side that weekend, since we had perfectly clear 
skies and a beautiful sunset. We spent two twilight hours on the top of the 
Duquesne Incline and got numerous images of the full downtown skyline with 
the new PNC Bank stadium lights!  The panoramic shown (on the cover) is an 
assembly of five stitched images using PanoramaMaker3 software.

The big surprise for us in Pittsburgh was the bridges!  Up close, several of them 
pose some really interesting compositional challenges, especially the Smithfield 
street bridge.  Most of them are quite old, made of iron, and date back to to 
P’burgh’s heyday as a heavy-weight steel-producing industrial giant.

FYI:  drivetime from this area is 4.5 to 5.5 hours. Avoid the Holiday Inn (the left 
hand doesn’t know what the right hand is doing there).

A Photographic Foray to Pittsburgh
Architecture, Bridges, Panoramic Views Make for Exciting Images 

by Don Andberg

Our Photo Talk meeting on October 8 will explore the subject of 
breaking the rules. Of course that presumes you know what the 
rules are. Therefore we will talk about those rules that have been 
around for years, like the rule of thirds, and see what happens if 
you decide that the image might just be better if the subject was 
in the bottom corner instead of the ideal power point placement. 
What’s wrong with a subject in dead center? With digital 
cameras and Photoshop, you can afford to experiment and put 
the subject in all kinds of places, right?

We have all heard the challenge to “… think outside the box,” 
in order to explore new ideas and be more creative. So, when 
it comes to photography the same holds true. Even the most 
advanced photographers sometimes get into a rut and say that 
they have not done anything new in awhile. It’s often too easy 
to find the same places, subjects and experiences and end up 
creating similar images to the same ones you took last year. And, 

if you are like me it’s time to break those habits and explore more 
exciting photography.

What other rules can you think of that need to be broken from 
time to time? Does every photo have to be tack sharp? Bring 
your ideas and suggestions about what rules need to be broken 
from time to time. If you have been successful in breaking the 
rules in the past and created winning photos, let’s talk about 
what got you to that point. Did you do anything creative during 
the summer months? Photo Talk gives us the opportunity 
to explore what happens in our minds eye to make a more 
interesting image. And, our club members are eager to share 
their ideas about their photography.

As was our practice last year, we will start the night with a 
review of images from the prior week’s competition. If you have 
printed images from a prior competition that you want to talk 
about, feel free to bring them to the meeting.   

Photo Talk Meeting: October 8
Breaking the Rules—How to Boost Your Photo Creativity by Thinking Outside the Box (i.e., Camera)

by Steve Bruza, VP for Photo Talk
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The central theme must be a mirror image of an object as seen 
when reflected by glass, water, metal or some other reflective 
surface. The object may be included in the photograph but the 
central theme must be the reflected image. The judge will be 
Andy Klein.

Photography has been an interest for Andy for a long time. 
After cajoling, his parents bought a used Argus C3 when he was 
eleven. Andy spent some years in the black and white darkroom 
as student, printer, and teacher and moved over to color slides 
and B&W slides where he has been for many years.

Tutelage from former a Washington Post photographer, classes 
from Joe Miller, Freeman Patterson, Maine Photographic 
Institute, Santa Fe Photography School, and miscellaneous 
other coursework and mentors have helped Andy build his skills. 
He is an active member of Northern Virginia Photographic 
Society having held all the officer positions over the years.

Andy’s photographs have been published, won occasional 
prizes, sold, supported court cases. He is a recent graduate of 
Joe Miller’s class on judging and has served as a camera club 
competition judge for a number of years.

Andy likes a variety of photographic subjects and shoots Nikon 
and Leica cameras. He has been in the digital darkroom for several 
years and only recently has largely left film for digital capture.

When it comes to judging, Andy says that, “Impact 
(Communication) trumps almost everything else. If the 
photograph has a strong communication about beauty, life, 
death, fun, silliness, the human condition or any other aspect of 
life and the world around us then this is a “good” photograph. 
Craftsmanship, Creativity, and Composition are what takes a 
strong message and makes it a prizewinner. Creativity can do 
a lot, but craftsmanship and composition are not sufficient to 
achieve prizewinning stature.”

Competition Meeting: November 5
Theme: Reflections; Judge: Andy Klein

by Clarence Carvell, Competition Assistant

On Saturday, October 13, we will venture up to the historic 
town of Port Deposit on the Susquehanna river, just below the 
I-95 bridge.  This is one of those sleepy little towns that has 
languished in semi-obscurity as a vestige of the past shipping/
transportation system, and has a lot of quaint historic interest.  

The entire town of Port Deposit was placed on the National 
Historic Registry in 1978. The town has a number of impressive 
older buildings, many built of the local granite or brick. The 
oldest structures in town historic district date from 1725 to 
1928; the majority of these buildings were built from 1830 
through 1890’s.  The town is dramatically wedged between the 
steep & high bluffs on the north and the river on the south.  For 
more info on the town, see http://en.wikipedia.org/wiki/Port_
Deposit_Maryland. 

Also, if Fall foliage color has progressed enough, the riverside 
drive on highway 222 up to the Conowingo dam may be worth 
a look, including possible views of the river.  The roadway is a 
beautifully rural drive, with over-arching tree cover.  Don’t know 
where we’ll eat lunch, but probably in Port Deposit.  I’m sure the 
few eateries there will appreciate the patronage of a half dozen 
hungry photographers.

Let’s meet at the UMBC Park & Ride, one mile east of I-95 on 
route 166 (exit 47, the same roadway that takes you to BWI 
airport), at 10AM.  It’s about a 45 minute drive from there.  
And, if the weather forecast is for a 60% or greater chance of 
rain, I’ll be at home photoshopping on my computer!!  Contact 
Don at dbandberg@aol.com OR 410 772-3233, OR 443 812-
1217 (cell). 

Field Trip: Port Deposit on the Susquehanna
October 13 Trip to Historic Town Offers Many Photo Opportunities

by Don Andberg, Field Trip Captain

Have You Paid Your Club Dues? 
Be Sure to Join or Renew in Time to Compete in the October Competition.
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We are going to try something new this month. Victor from 
NIK Software will be giving a demonstration on how to use 
their creative filters. These are very useful plugin filters for all 
versions of Photoshop. 

Victor will not be able to appear in person due to a trade show 
commitment that weekend, but he has arranged for us to have 
him at our meeting by setting up a net meeting. We will see him 
and be able to interact with him over the Internet. Dick Russell 
and I are going to practice this and work out the bugs prior to 
meeting night. So, I hope everything goes smoothly.

In addition to the program, a door prize—a DVD titled 
Automating Photoshop CS2, featuring Matt Kloskowski—will 
be given at the end of the meeting.. The DVD will show how to:

• Create Actions 
• Use Droplets 
• Build actions with conditional logic 
• Add a whole new level of custom automation 
• Learn how to troubleshoot your own actions

Learn all these secrets, plus much more about creating actions.

How-To Meeting: October 22
Using NIK Software’s Creative Filters

by Bill Conway, VP for How-To

How much sharpening is enough? We’ve all asked ourselves that question. Digital images usually need some sharpening. So here is a 
sharpening workflow that will allow you to get the most sharpening possible.

Step One

Always sharpen as the last step in your workflow so that it will be appropriate for the size and resolution of your finished image. Save 
your image as a “Master Image File” with all of your layers intact, incase you want to do some more editing in the future you will not 
be editing an already sharpened image. Create a duplicate image file, Image>Duplicate, flatten the layers, Layers>Flatten, to ensure 
that all pixels on all layers are sharpened equally, and resize, Image>Resize, to the output and image resolution desired. Then it’s time 
to sharpen.

Step Two

It’s important that you sharpen while viewing your image at 100 percent view (Actual Pixels) of your image. Size your image to fit 
your screen, View>Fit On Screen, you can then use the smaller window in the Unsharp Mask to view the sharpening. It defaults to 
100 Percent View. By having the full image on screen it allows you to click anywhere on the image causing the preview window to 
center on that area allowing you to check sharpening in specific areas quickly.

Step Three

Bring up the Unsharp Mask dialog, Filter>Sharpen>Unsharp Mask. Before you start adjusting stop and think about your image. Is 
it an image that contains a lot of fine detail or an image that contains a lot of smooth textures? The best sharpening will be different 
for each image type.

Step Four

The most important setting in Unsharp Mask is Radius, which determines the size of the sharpening halos that are created. To 
best evaluate the Radius, setting start by setting Amount to the maximum, 500 percent and the Threshold to the minimum value 
of Zero.

Technical Talk
Sharpening

by Bill Conway, VP for How-To

continued on page 7
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Step Five

Adjust the Radius to make a halo size that is most pleasing for your image by checking various key areas in your image as you adjust 
this setting. For high detail images you will use a relatively low Radius, around 0.1 to 1.0. For lower detail images the value will most 
likely end up between 2.0 and 3.0, when in doubt compromise with values between 1.0 and 2.0. You are looking for a Radius size 
that enhances edge contrast without creating a glow around the edges.

Step Six

Now with the Radius size set, start reducing the amount setting so the halos have a pleasing intensity. For high detailed images 
where a low Radius was used higher an Amount in the range of 200 to 300 percent will probably provide the best image quality. For 
lower detail images that use a higher Radius value, a lower Amount in the range of 75 to 125 percent will probably be best.

Step Seven 

To prevent creating the “Crunchy” texture in the smooth areas, Sky, Water, etc. you will need to increase the Threshold value, so that 
areas with minimum contrast aren’t sharpened. Click on an area in your image that contains smooth textures that you want to keep 
so you can preview that area in the Unsharp Mask dialog box. Slowly increase the Threshold setting to a value that preserves the 
smooth textures. In most cases, a value of 4 to 8 will be best.

Step Eight

Evaluate various key areas of your image to confirm that your settings are optimum. For printing an ever so slightly over sharpened 
image is ok. You can click on the preview in the Unsharp Mask preview window to see the “before” version without sharpening 
applied, releasing to see the sharpened version. Fine tune the setting keeping in mind the techniques discussed earlier then click 
Ok to set the sharpening.

Save the file as your final sharpened image, confident that you can print a tack sharp image. After doing this a few times you will be 
able to instinctively sharpen you images in a very short time.

Technical Talk
Sharpening

continued from page 6

Ansel Adams, at the Corcoran Gallery, take s a new look at the 
work of this important and influential photographer through 
approximately 125 images drawn from The Lane Collection at 
the Museum of Fine Arts, Boston. Acquired directly from the 
artist during a 10-year period in the early 1960s and 1970s, the 
photographs showcase Adams’ extraordinary range and span 
the length of his six decade career, with particular emphasis on 
his early work. Rarely exhibited prints are presented along with 
several of Adams’ iconic landscapes, offering new insight into 
one of the very few photographers in the history of the medium 
whose name and images enjoy worldwide recognition.

Known primarily for his dramatic black-and-white vistas of 
Yosemite National Park in the Sierra Nevada mountain range, 
Adams was in fact a versatile photographer who made portraits 
of artist friends, close-up nature views, striking architectural and 
urban views, and documentary images. Ansel Adams is arranged 
chronologically and divided into several sections.

Tickets are required for this exhibit that runs through January 
27, 2008. They may be obtained at the Corcoran admission desk 
or online through Ticketmaster. Other programs and lectures 
will be held in conjunction with the exhibit.

Ansel Adams at The Corcoran
125 Images from Monochrome Master on Display in Washington, DC

from www.corcoran.org/adams/index.html
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